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FCC Notice

This device has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful interference
in a residential installation. This device generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with
the instruction, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a
particular installation. If this device does cause harmful interference to
radio or television reception, the user is encouraged to try to correct the
interference by one or more of the following measures:

O Reorient or relocate the receiving antenna.
O Increase the separation between the computer and receiver.

O Connect the computer inte an outlet on a circuit different from that
to which the receiver is connected.

O Consult the dealer or an experienced radio/TV technician for help.

FCCID: IBACT-MMU3DO I

CAUTION

To comply with the limits for the Class B digital device, pursuant to Part
15 of the FCC Rules, this device must be installed in computer equipment
certified to comply with the Class B limits. All cables used to connect the
computer and peripherals must be shielded and grounded.Operation
with non-certified computers or non-shielded cables may result in
interference to radio or television reception.

MODIFICATIONS

Any changes or modifications not expressly approved by the grantee of
this device could void the user’s authority to operate the device.
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Introduction

Welcome to the next generation of entertainment on the PC.

3DO Blaster and 3DO Player transform your PC into the ultimate game
machine. Utilizing The 3DO Company’s revolutionary 32-bit graphics
technology, 3D0 Blaster will allow your computer to play any 3DO title.
You can now have all the fun on your computer that previously only
standalone 3DO sets could give.

This guide will help you install and configure your 3DO Blaster in your
computer. Read and follow its instructions for trouble-free installation
and use.

Before You Begin

Before you begin setting up the contents in your package, you should read
the following:

O Checking System Requirements
Obtaining Latest Information
Making a Copy of Your Diskettes
Using this Guide

Document Conventions

Ooo0oOO0o

Checking System Requirements

Vi

You need to verify that your system meets the following requirements:

O

IBM 386SX, 386, 486, Pentium, or 100% compatibles

Creative Labs CR-563 double speed CD-ROM drive

2 MB free hard disk space (minimum)

VGA monitor

VGA card with VESA compatible feature connector

Sound Blaster Pro, Sound Blaster 16, or Sound Blaster AWE32
Speakers

16-bit ISA expansion slot

oooooO0d0od

Windows version 3.1

Obtaining Latest Information

The README file in the installation diskette contains the latest
information and changes not available at the printing time of this manual.
Please read this file when prompted to during software installation.

Making a Copy of Your Diskettes

If you have not made a copy of the original diskettes that came with your
package, you should do so before installing the software in your system.
Store your original diskettes in a dry and cool environment.

Using this Guide

This User’s Guide is designed so that you can install and begin using 3DO
Blaster in the quickest way possible.

If you are new to 3DO Blaster or peripheral cards, read Chapter 1 in detail
to orientate yourself with the components of 3DO Blaster.

Once you have the information in the first chapter, you can go on to
Chapters 2 and 3 to install the hardware and software from your package.
During installation, you may need to read Chapters 5 to change certain
hardware settings of your 3DO Blaster for it to work in your particular
computer.

After the hardware and software have been installed properly, you can
read Chapter 4 to begin playing your 3DO titles.

The following are brief descriptions of each chapter:

Chapter 1 “Knowing 3DO Blaster”

This chapter contains information on the connectors and jumpers of your
3DO Blaster. Read this chapter to find out what they are and what they
are used for.

Chapter 2 “Setting Up Your Hardware”

Information on how to install 3DO Blaster is found in this chapter. Read
and follow the instructions provided here carefully when you install this
item in your computer.

vii
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Chapter 3 “Setting Up Your Software”

This chapter tells you how to install the software from your package.
Read it to find out how to use the Windows installation utility and
configuration program that come with the installation diskette.

Chapter 4 “Using 3DO Player”

Instructions on how to start and use this software application that plays
your 3DO titles are found in this chapter. Read it completely to make full
use of the 3DO Player.

Chapter 5 “Changing 3DO Blaster Hardware Settings”

The information contained in this chapter helps you to change the base /0
address hardware setting of your 3DO Blaster. Read this chapter only if
you have a hardware conflict between your 3DO Blaster and another
peripheral card in your computer.

Appendix A “Using 3DO Video Overlay Setup”

If you encounter problems displaying images from your 3DO titles, read
this chapter for information on how to use the 3DO Video Overlay Setup
utility to correct the problems.

Appendix B “Troubleshooting Guide”

Information contained in this appendix will help you to troubleshoot
common problems that you may encounter when you install or use 3DO
Blaster. If you have a problem, look in here for a solution before calling
our technical support.

Appendix C “Technical Support”

This appendix lists our contact numbers and addresses for you to call or
write to if your have any questions or comments about your 3DO Blaster,
Refer to these numbers and addresses if you cannot find a solution to your
problem in the Troubleshooting Guide in Appendix B.

Appendix D “General Specifications”

Detailed specifications of your 3DO Blaster arc provided in this appendix.
Read this appendix for more information about the hardware in your
package.

Document Conventions

The information in this guide follows certain conventions that are adopted
to help you locate and identify the information. These conventions
provide consistent text formats and cues, and are designed to ensure that
information is easily identifiable.

The conventions are:

italics Variable quantities that are not fixed and which you
can change.

<KeyName> Names of keys on your keyboard.
ALL CAPS Directory names, filenames, and acronyms.

BOLD CAPS Commands, switches or parameters, and text that must
be typed exactly as they appear.

P o

. is used to denote an area of text where

Additionally, the symbol

information or instructions must not be taken lightly but should be noted
or followed.



Knowing Your 3DO Blaster

This chapter helps you locate and identify the components of your 3DO
Blaster, The components of your card are divided into the following

categories:

[ Cables
0 Connectors

O Jumpers

Cables

Cables are wires with connectors at both ends. They connect your 3DO
Blaster to other devices and help transport signals between your 3DO
Blaster and other devices. They make essential connections for your 3DO

Blaster to work properly.

The cables supplied with your 3DO Blaster are shown in Figures 1-1, 1-2,
and 1-3.

To
_> VGA

Card

Figure 1-1: VGA Loopback cable.
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Figure 1-3: CD Audio cable.

VGA Loopback Cable

The VGA Loopback cable connects your VGA card to your 3DO Blaster.

[t has male 15-pin D-Shell connectors at each end that join with the
female connectors of your VGA card and 3DO Blaster.

VGA Feature Connector Cable

The VGA Feature Connector cable connects your 3DO Blaster’s VGA
Feature connector to your VGA card’s VGA Feature connector. It has a
slot connector and a 26-pin female connector at one end and another
26-pin female connector at the other end. This cable carries necessary
digital signals from the VGA card for your 3DO Blaster to work.
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CD Audio Cables

The two CD Audio cables supplied are identical. They are used for
carrying audio signals from your Creative CD-ROM drive to your 3DO
Blaster and to your audio card. Without them, audio from your CD cannot
be heard.

Connectors

Connectors, or ports as they are also called, are connecting interfaces
consisting of many pins that allow you to attach other devices to it.

There are several connectors on your 3DO Blaster. They are found on the
card’s surface and its rear panel. The connectors on your card are shown
in Figure 1-4.

CD-ROM VGA CD cD
Data ™, Feature ', Audio Out ", Audio In

\ \
3D0
Control

Ill
.!I - VGA Out

“VGAIn

FMV Daughterboard
Figure 1-4: The connectors on your 3D0 Blaster.

The following sections describe the purpose of each connector.

CD-ROM Data Connector

The CD-ROM Data connector allows you to connect your 3DO Blaster to
a Creative CD-ROM drive using a CD-ROM Data cable. Detailed
instructions are provided in Chapter 2.

Knowing Your 3DO Blaster i-3



CD Audio-In Connector

The CD Audio-In connector allows you to connect the audio output from
a Creative CD-ROM drive to your 3DO Blaster. This connector will
enable your 3DO Blaster to obtain audio from CDs.

CD Audio-Out Connector

The CD Audio-Out connector allows you to connect the audio output from
your 3DO Blaster to your audio card. This connection lets your 3DO
Blaster send audio signals to your audio card.

VGA Feature Connector

This is a 26-pin connector that connects to your VGA card via the VGA
Feature Connector cable. When connected, digital VGA signals can be
sent from the VGA card to your 3DO Blaster.

VGA In Connector

This is a 15-pin D-shell connector that connects to your VGA card via the
VGA Loopback cable. When connected, VGA signals can be sent to your
3DO Blaster.

VGA Out Connector

This is a 15-pin D-shell connector that connects to the VGA monitor via
the VGA monitor’s cable. When connected, analog VGA signals can be
sent to the VGA monitor.

3DO Control Port

This is a 9-pin D-shell connector that connects to a 3DO control pad.
When connected, you can use the control pad to control your 3DO title.

FMV Daughterboard Connector

This connector allows for future upgrades.
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Jumpers

A jumper is a group of pins that you can configure to define a hardware
setting of your 3DO Blaster (see Figure 1-5). For example, you can use a
jumper to set a different base I/O address for your 3DO Blaster.

Figure 1-5: A jumper.

The jumpers found on your 3DO Blaster are divided into pairs of pins.
You can configure a jumper by enabling or disabling any of its pairs of
pins. A pair of pins is enabled when a jumper block is placed over it as
shown in Figure 1-6.

Jumper Block

Figure 1-6: An enabled pair of pins.

Knowing Your 3DO Blaster 1-5



A pair of pins is disabled when there is no jumper block placed on it or
when a jumper block is placed over one pin as shown in Figure 1-7.

Figure 1-7: Two ways a pair of pins can be disabled.

Identifying the Base 1/0 Address Jumper

The base I/O address jumper on your 3DO Blaster is shown in Figure 1-8.

not and should not change any of them.

Other jumpers on your 3DO Blaster are for factory use. You need

2

|

| RESEIESS R S92 CnR NOs

[
E
=

Base I/O Address
Setting

Figure 1-8: The base I/0 address jumpers at default setting.

The Iﬂ symbol indicates an enabled jumper.
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Knowing the Base I/O Address Jumper Seffing

1/0 addresses (or /O address range) are areas of memory used by your
computer’s microprocessor to distinguish among various peripheral
devices connected to your system when sending or receiving data. Your
3DO Blaster is such a peripheral device and occupies a changeable I/O
address range. This range is represented by the base I/O or first address of
that range. For your 3DO Blaster, the factory default base I/O address is
260H (260H means hexadecimal number 260) and is set by the
configuration of jumper JP5 in the manner shown in Figure 1-9. You
need to change this factory default setting of JP5 if another peripheral
device in your system uses the same address. Instructions are provided in
Chapter 5.

260H
Figure 1-9: Base I/O address factory default setting 26011,

Other base I/O addresses set by JP5 are 270H, 280H, and 290H. Their
corresponding I/O address ranges and the factory default’s are:

Table 1-1: Available base /O addresses and their ranges.

Base I/O Address /O Address Range
| 260H (Factory Det"auit) . 260H tb 26FH
270H 270H to 27FH
280H 280H to 28FH
290H 290H to 29FH

Refer to Figure 5-3 to see the jumper settings for the above base
[/O addresses.

Knowing Your 3DO Blaster 1-7



Setting Up Your Hardware

This chapter helps you install the 3DO Blaster hardware card into your
computer and shows you how to make the necessary connections for it to
function. If you are unfamiliar with 3DO Blasters, read Chapter 1,
“Knowing Your 3DO Blaster,” first to familiarize yourself with it.

It is divided into the following sections:

U Installing Your 3DO Blaster

O Connecting Your 3DO Blaster to Creative CD-ROM Drive
O Connecting 3DO Control Pad to Your 3DO Blaster

U Connecting Your 3DO Blaster to Other Devices

Installing Your 3DO Blaster

el

If your audio card and Creative CR-563 CD-ROM drive are not
installed in your system, please install them, including their
software, before you set up your 3DO Blaster. Refer to your audio
card and CD-ROM drive documentation for installation
instructions.

Before you install your 3DO Blaster, you need to verify that its base I/O
address jumper, JP5, is configured correctly. Note that your 3DO Blaster
has a factory default base /O address of 260H. Check that the base I/O
address jumper on your card is configured to this setting using Figure 2-1
below.

260H

Figure 2-1: Factory default base I/O address setting 260H.
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If your 3DO Blaster’s base I/O address (or any address in its range) is

used by another peripheral card, you need to change that setting of your

3DO Blaster. To do so, refer to Chapter 5, “Changing 3DO Blaster
Hardware Setting”,
To install your 3DO Blaster:

. Touch your system’s metal casing to ground yourself and
discharge any static electricity in your body (see Figure 2-2).

Figure 2-2: Discharge static electricity.

2. Switch off your system and all peripheral devices. Unplug the
power cord from the wall outlet as depicted in Figure 2-3.

Figure 2-3: Remove power cord from wall outlet.

3DO Blaster User's Guide

Your power cord and wall outlet may differ from those shown.

3. Remove the cover from your system (see Figure 2-4).

gy

Figure 2-4: Remove system cover.

4. Locate a free 16-bit expansion slot (see Figure 2-5) next to your
VGA card.
If no free slot is available, rearrange the peripheral cards so that
your VGA card has a free slot next to it.

€

. gbitslot

16-bit slot

Figure 2-5: Locate free 16-bit slot.
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5. Remove the metal plate from the expansion slot you have chosen
as shown in Figure 2-6. Put the screw aside.

This screw will be used later to secure the mounting bracket of the
card. Also, keep the metal plate in case your 3DO Blaster is
removed from the expansion slot and you need to cover the slot.

mmmuu:ﬁ

Figure 2-6: Remove metal plate from slot.

6. Align your 3DO Blaster’s gold-stripped expansion bus connector
with the free expansion slot and gently lower your 3DO Blaster
into the slot (see Figure 2-7).

Do not force your 3DO Blaster into place. If it does not fit
properly, gently remove it and try again.

Figure 2-7: Inserting 3DO Blaster into slot.
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7. Secure your 3DO Blaster to the expansion slot with the screw you
removed from the metal plate as shown in Figure 2-8.

g

)

iy

Figure 2-8: Securing 3DO Blaster.

Your 3DO Blaster is now installed. Go on to the next section to make the
necessary connections for your 3DO Blaster to work.

Setting Up Your Hardware 2-5



Connecting Your 3DO Blaster to Creative CD-ROM Drive

2-6

Two connections need to be made between your 3DO Blaster and your

Creative CD-ROM drive so that the drive can send data and audio signals

to your card. Specifically, you need to reconnect the existing CD-ROM
Data and CD Audio cables to your 3DO Blaster.

-

Make sure the ID jumper setting at the rear panel of the

(see Figure 2-9). Refer to your drive’s documentation to change
drive IDs.

Drive ID 0

Figure 2-9: Your CD-ROM drive's ID jumper setting

To connect your 3DO Blaster to your Creative CD-ROM drive:

1. Disconnect the CD-ROM Data cable that is currently connected to

your Creative CD-ROM drive from the peripheral card that it is
connected to.

your drive.

2. Reconnect the CD-ROM Data cable to the CD-ROM Data
connector on your 3DO Blaster as shown in Figure 2-10.

Ensure that the colored wire on the cable is aligned with
Pin 1 of the connector.

3DO Blaster User’s Guide

CD-ROM drive you are connecting your 3DO Blaster to is set to 0

Ensure that the other end of the cable remains connected to

To Creative
CD-ROM Drive CD-ROM
Data Cable

Colored Wire

CD-ROM Data
Connector . l Pin 1
~ Y. — &
3DO Blaster ] =l [l j
1 M

Figure 2-10: Reconnect CD-ROM Data cable from Creative CD-ROM drive to
3DO Blaster.

3. Disconnect the CD Audio cable that is currently connected to your
Creative CD-ROM drive from the peripheral card that it is also
connected to.

it

Ensure that the other end of the cable remains connected to
your drive.

4, Reconnect the CD Audio cable to the CD Audio-In connector on
your 3DO Blaster as shown in Figure 2-11.

To Creative
CD-ROM Drive

7 CD Audio In
 cDAudioCable Ul Connector
/ — |

/

@lﬁ'ﬂ

3DO Blaster ]
Hl
Bl

1 M4

Figure 2-11: Reconnect CD Audio cable from Creative CD-ROM drive to CD
Audio-In connector of 3DO Blaster.
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Connecting Your 3DO Control Pad to Your 3DO Blaster

To use the 3DO control pad supplied in your package, you need to
connect it to your 3DO Blaster. Attach the control pad’s cable to the 9 pin
(DBY9) 3DO Control port at the back panel of your 3DO Blaster (see
Figure 2-12). Your 3DO control pad is now ready for use. Chapter 4,
“Using 3DO Player™ tells you how to use it to control your 3DO titles.

3D0 Control Port

3D0 [t
Control 11 L
Port L

VGA Output |

VGA Input | |
3D0 Blaster

Figure 2-12: Connecting 3D0 Control pad to your 3DO Blaster.
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Connecting Your 3DO Blaster to Other Devices

You need to connect your 3DO Blaster to your audio card, VGA card, and
VGA monitor to hear sound and see images from your 3DO titles.

Connecting Your 3DO Blaster to Audio Card

In order to hear sound, you need to connect your 3DO Blaster to the audio
card in your computer.

To connect your 3DO Blaster to audio card (see Figure 2-13).

1. Connect a second CD Audio cable to the Audio-Out connector on
your 3DO Blaster.

2. Connect the other end of the cable to the CD In connector on your
audio card.

CD Audio Out
Connector

300 Blaster Efn i

Jos]

a
E
I:

-~ CD Audio Cable

m
CD Audio
Connector ¢

.
B :

B

L |p

B

Audio Card I“

Figure 2-13: Connect CD Audio-Out connector on 3D0 Blaster to CD In
connector on audio card using CD Audio cable.
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Connecting Your 3DO Blaster fo VGA Card

You must make two connections between your 3DO Blaster and VGA

card. The first is between the VGA Feature connectors of both cards. The
second is between the VGA Input connector of your 3DO Blaster and the

VGA Output connector of your VGA card.

To connect the VGA Feature connectors of your 3DO Blaster and VGA
card:

1. Attach the 26-pin female connector end of the VGA Feature
Connector cable to the VGA Feature connector on your 3DO
Blaster (see Figure 2-14).

Ensure that the colored wire of the cable is aligned with
Pin 1 of the connector,

Pin1

To
w300
Control Pad

3DO Blaster

Colored
VGA Feature Wire

Connector Cable

Figure 2-14: Conneciing the VGA Feature connectors of 3DO Blaster and the
VGA card using the VGA Feature Connector cable.
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2. Attach the other end of the VGA Feature Connector cable to the
VGA Feature connector of your VGA card as shown in
Figure 2-14.

The VGA card in your system may have either a slot or
26-pin male VGA Feature connector. Use the
corresponding connector on the free end of the VGA
Feature Connector cable to connect to the VGA card.

To connect the VGA Input connector of your 3DO Blaster to the VGA
Output connector of your VGA card (see Figure 2-15):

1. Attach one end of the VGA Loopback cable to the VGA Input
connector of your 3DO Blaster.

3D0 To
Control s 300
Port Control Pad

VGA Qutput | ]

""-_—t
veamput |1 [H]l] 8
3D Blaster —
VGA
Loopback
Cable

VGA Card

Figure 2-15: Connecting the 300 Blasier o VGA card using the VGA Loopback
cable.

2. Attach the other end of the VGA Loopback cable ta the VGA
Output connector of your VGA card.
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Connecting Your 3DO Blaster to VGA Monitor

To view images from your 3DO Blaster and the VGA card on your VGA
monitor, connect the VGA monitor’s cable to the VGA Output connector of
your 3DO Blaster as shown in Figure 2-16.

To 3DO
Control Pad
300
Control
Port
VGA QOutput [ 3
VGA Monitor =
i Cable i
VGA Input [: 7_,;::_:,——'::—%
300 Blastg_r_ . _ VGA Monitor

VGA Card

Figure 2-16: Connecting 3DO Blaster to VGA monitor.
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Setting Up Your Software

After installing and connecting your 3DO Blaster, you can begin setting
up the software for your package. The software set up process involves
setting up the software for your 3DO Blaster and running the 3DO Blaster
Configuration utility.

This chapter is organized thus:

O Setting Up 3DO Blaster Software
U Using the 3DO Blaster Configuration Utility

Setting Up 3DO Blaster Software

Before you proceed to set up the software for your 3DO Blaster,
you must install the software for your audio card and Creative
CD-ROM drive, if you have not already done so. Refer to your
audio card’s Getting Started and CD-ROM drive’s documentation.

The first step in setting up your 3DO Blaster’s software is running the
SETUP.EXE program. This program is found in the 3DO Blaster
installation diskette provided in your package. SETUP.EXE creates a
directory in a drive of your choice to store all the necessary files needed
for 3DO Blaster to work including those that are needed to run the 3DO
Player application. As SETUP.EXE runs only in Windows, ensure you
have Windows 3.1 installed before running it.

To run SETUP.EXE:
1. Insert the 3DO Blaster installation diskette provided into a disk
drive.

2. If you are not in Windows, type WIN at the DOS prompt to start
Windows.
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6. Inthe Welcome dialog box, choose Continue.

S The Setup Options dialog box in Figure 3-3 appears
e ;

box in Figure 3-1 appears.

Command Line:
| ]

[ Run Minimized

Figure 3-1: The Run dialog box.

3. Inthe Command Line text box, enter the path and name of your
SETUP.EXE program. For example, if your installation diskette is Figure 3-3: The Setup Options dialog box.
in drive B, type BASETUP. The window in Figure 3-2 appears.
7. Choose Install Player.
The Installation Path dialog box in Figure 3-4 appears.

Figure 3-4: The Installation Path dialog box.

8. If you do not want to use the default path of C:A\3DO to store the
3DO Blaster software, enter your desired path in the Path text box.

Figure 3-2: The 3DO Player Setup window.

4. In the Welcome dialog box, choose Read Me to obtain important
information that you need to know about 3DO Blaster.

5. After you have finished reading the information, select Exit from
the File menu.

Setting Up Your Software 3-3
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9. Choose Continue.

The VoiceAssist User Files Installation dialog box in Figure 3-5
appears.

ist User Files Installation

Figure 3-5: The Voicedssist User Files Installation dialog box.

If you have VoiceAssist installed, you can install custom
YmceAssist user files of the 3DO Player and the bundled 3DO
titles so that you can use voice to control them.

10. Choose Yes if you want to use VoiceAssist with your 3DO Player.

1(_fhoose No if you do not want to use VoiceAssist or if you do not
ave it,

If_ you chose Yes, the VoiceAssist Installation Path dialog box in
Figure 3-6 appears.

Figure 3-6: The Voicedssist Installation Path dialog box.

Enter the path where your VoiceAssist software is stored and
choose Continue.

SETUP.EXE creates the directory that you specified and copies all of the
necessary 3DO files into that directory and the Windows directory. The
custom VoiceAssist user files are copied into your VoiceAssist directory.
Once that is completed, the 3DO Blaster program group is created.
SETUP.EXE then starts the 3DO Blaster Configuration utility to create the
environment statement needed for your 3DO Blaster to function. The
following section tells you how to use this utility.

3D0 Blaster User's Guide

Using the 3DO Blaster Configuration Utility

When the 3DO Blaster Configuration utility starts, the dialog box in
Figure 3-7 appears.

Figure 3-7: The 3DO Blaster Configuration dialog hox.

You can use this dialog box to set the environment statement for your
3DO Blaster. To do so:

1. In the list box, select the base /O address that corresponds to the
one set by the jumper on your 3DO Blaster.

2. Choose OK.

The 3DO Blaster Configuration utility checks if the base I/O address you
specified in the list box is the same as that specified by the base /O
address jumper on your 3DO Blaster. If they are different, you have to
specify the correct address in the list box.

The 3DO Blaster Configuration utility also begins checking your
computer for another peripheral device with the same base I/0 address. If
another peripheral device is found with the same base I/O address, you
have to change the base 1/0 address jumper setting on your 3DO Blaster
(refer to Chapter 5, “Changing 3DO Blaster Hardware Setting,” for
instructions) and run the 3DO Blaster Configuration utility again (icon
found in the 3DO Blaster program group).

The utility also checks your audio card for the port address of its
C'D-ROM interface (if one exists). If the port address is the same as the
base I/O address you selected for your 3DO Blaster, a window appears
notifying you of that. You need to refer to Chapter 5 to change the base
/0 address jumper setting on your 3DO Blaster and run the 3DO
Configuration utility again.
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It no conflict is found, the 3DO Blaster Configuration utility modifies
your computer’s AUTOEXEC.BAT and CONFIG.SYS files as follows:

CONFIG.SYS

O Update the /P paramelter of your Creative CD-ROM drive’s
DEVICE statement (statement loading SBCD.SYS) with the base
1/0 address of your 3DO Blaster.

O Add /T:2 to your Creative CD-ROM drive’s DEVICE statement
(statement loading SBCD.SYS). /T:2 specifics that your CD-ROM
drive is connected to your 3DO Blaster.

After the above two modifications, the statement loading
SBCD.SYS should look like:
DEVICE=path\SBCD.SYS /D:MSCDO01 /P:260 /T:2

where path is the drive and directory your SBCD.SYS is stored.
Note that other parameters may be present.

 Add the following statement to the line just before your Creative
CD-ROM drive’s DEVICE statement:

DEVICE=CA\3DONCD3DOBLT.SYS /P:260
where

C:\3DO  Specifies the drive and directory location of your 3D0O
Blaster software, the factory default being C\3DOQ.
This phrase is different if you specified a different
location to install your 3DO Blaster software.

/P:260 Specifies the base 1/0 address of your 3DO Blaster, the
factory default being 260H. This phrase is different if
you installed your 3DO Blaster at a different base 1/0
address.

3DO Blaster User's Guide

AUTOEXEC.BAT
O Add the following statement:

SET 3DOBLST=C:\3DO A:260
where

C:\3DO  Specifies the drive and directory location of your 3DO
Blaster software, the factory default being C:\3DO.
This phrase is different if you specified a different
location to install your 3DO Blaster software.

A:260 Specifies the base I/O address of your 3DO Blaster, the
factory default being 260H, This phrase is different if
you installed your 3DO Blaster at a different base I/O
address.

The statement added to your CONFIG.SYS file loads the
CD3DOBLT.SYS device driver that enables your Creative CD-ROM
drive to switch from 3DO mode to normal CD-ROM mode. This device
driver must always be loaded before your Creative CD-ROM drive’s
SBCD.SYS driver. Hence, if you edit your CONFIG.SYS file with a text
editor, ensure that the DEVICE statement loading CD3DOBLT.SYS is
always one line before the DEVICE statement loading SBCD.SYS.

Once the AUTOEXEC.BAT and CONFIG.SYS files are modified, the
3DO Blaster Configuration utility reboots your computer. The
environment statement contains environment settings for your 3DO
Blaster and is executed every time your computer starts up. This is done
so that your computer can recognize the presence of 3DO Blaster.

Your 3DO Blaster’s software is now installed. You can reverse the
installation process resulting in removal of all 3DO software and the
installation directory created by SETUP.EXE. To do that, choose
Uninstal] Player in the Setup Options dialog box shown in Figure 3-3.
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Using 3DO Player

3DO Player is the application that allows you to play your 3DO titles in
the Windows environment on your PC. This chapter describes 3DO
Player and gives you instructions to use its features.

It is organized into the following sections:

|

[ I Ry Wy

Starting 3DO Player

Knowing the 3DO Player Window
Starting a 3DO Title

Controlling a 3DO Title
Customizing 3DO Player

Saving a Title

Quitting 3DO Player

Using 3DO Player
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Starting 3DO Player

To start 3DO Player:

1. Double-click the 3DO Player icon in the 3DO Blaster group
window.

The window similar to the one in Figure 4-1 appears.

Control Menu
Menu Bar

Tool Bar

Player Screen

Status Bar

Figure 4-1: The 3D0O Player window.

If the Creative 3DO Blaster title screen seen in Figure 4-1 does not
appear or is distorted, refer to Appendix A to find out how to use
the 3DO Video Overlay Setup to obtain a proper display.

Knowing the 3DO Player Window

The 3DO Player window has five main features, They are:

O Control Menu
Player Screen
Status Bar
Menu Bar

Tool Bar

O ooo
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Control Menu

This menu contains standard Windows commands for manipulating and
closing the 3DO Player window.

Player Screen

The player screen displays images from your 3DO titles as well as the
memory resident introduction clip. The player screen can be resized by
dragging the border of the 3DO Player window. You can also enlarge it to
oceupy your entire monitor screen by clicking the Full Screen button in
the tool bar.

Status Bar

The status bar provides information about the function of any of the tool
bar buttons or menu commands that your pointer is currently on top of.

Menu Bar

The menu bar contains the File, View, Emulation, Control, and Help
menus. These menus contain commands that allow you to work with your
3DO title, 3DO Control Pad, and online help. They are described in the
following sections.

File Menu

Exit Alt+F4

Figure 4-2: The File menu.

Reset Restarts the 3DO title that is in your Creative CD-
ROM drive.
Exit Quit 3DO Player.
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View Menu Conifrol Menu

View
Eull Screen Ctrl+F

Yolume... Ctrl+¥

o
J Status Bar Cirl+U Video Overlay.. Cirl+0
Freeze Ctrl+A G 5. The Control
Unfreeze Cuie? Figure 4-5: The Control menu.
Figure 4-3: The View men. Volume Display the Volume d{alog box to adjust the
volume of your 3DO title.
Full Sereen Enlarge the player screen to occupy your entire : ;
monitor screen. All other visible components Color Key DLSpl?{y the color key dialog box to change the
in the 3DO Player window are hidden. color key.
Always On Top Display the 3DO Player window above other Video Overlay Display the Video Overlay dialog box to change the
applications. overlay display mode of your 3DO Blaster.
Toolbar Enable or disable the tool bar.
] Help Menu
Status Bar Enable or disable the status bar.
Freeze Freeze the image in the player screen.
% 8 P Contents Fl
Unfreeze Unfreeze the image in the player screen.
Emulation Menu Figure 4-6: The Help menu.
e Contents Open a window showing the table of contents for
e topics concerning your 3DO Player.
Joy Stick Cirl+J

Keyboard Mapping... Cirl+E
Joy Stick Calibration... Cirl+L

About... Open a dialog box showing copyright information
and development credits for 3DO Player.

Figure 4-4: The Emulation menu.

Keyboard Enable or disable keyboard emulation of 3DO
control pad.

Joystick Enable or disable joystick emulation of 3DO
control pad.

Keyboard Mapping Open a dialog box to re-map 3DO control pad

buttons to keys on your keyboard.

Joystick Calibration Enable the Control Panel joystick calibration
utitliy to calibrate your joystick for 3DO
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Tool Bar

The tool bar shown in Figure 4-7 contains buttons for frequently used

menu commands. It can be toggled on or off using the Toolbar command

in the View menu.

Full
Screen

Always
On Top

Joystick Decrease
Unfreeze Emulation Volume

Increase
Volume

Keyboard
Freeze Emulation

| |

Figure 4-7: The 3DO Player tool bar.

The function of each button in the tool bar is as follows:

Always On Top

Full Screen

Freeze

Unfreeze

Keyboard Emulation

Joystick Emulation

Increase Volume

Decrease Volume
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Perform the same function as the Always On
Top command in the View menu.

Perform the same function as the Full Screen
command in the View menu,

Perform the same function as the Freeze
command in the View menu.

Perform the same function as the Unfreeze
command in the View menu.

Perform the same function as the Keyboard
command in the Emulation menu.

Perform the same function as the Joystick
command in the Emulation menu.

Increase the volume of audio output from your
3DO title through your audio card.

Decrease the volume of audio output from your

3DO title through your audio card.

Starting a 3DO Title

To start playing a 3DO title:

1. Inserta 3DO CD into your Creative CD-ROM drive.

2. Double-click the 3DO Player icon in the 3DO Blaster group.

The 3DO Player window in Figure 4-1 appears displaying the 3DO

Blaster introduction. At the same time, your Creative CD-ROM drive

begins reading the 3DO title and displays it in a few seconds.

If misalignment occurs between your 3DO title’s images and the
3DO Player window or no image is displayed in the player screen,

quit 3DO Player and start the 3DO Video Overlay Setup utility by

double-clicking its icon in the 3DO Blaster program group. This
utility helps you to fine tune alignment between the 3DO images
and your 3DO Player window. Refer to Appendix A to find out

how to use the utility. When you have finished using the utility,

quit it then start 3DO Player. 3DO Player will not work properly
if the setup utility is running at the same time.

Controlling a 3DO Title

The 3DO title you started can be controlled using one of the following:

@ Your 3DO Control Pad
O Your Keyboard
O Your Joystick

O Your Voice

Using 3D0 Player
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Using Your 3DO Control Pad

48

Your 3DO control pad is designed solely for controlling 3DO fitles.

Its buttons are laid out within your fingers’ reach so that you can register
your reactions faster when you are playing a 3DO ftitle. It can be used
once a 3DO title starts (provided the Keyboard or Joystick commands in
the Emulation menu are unchecked). Figure 4-8 shows the features of
your 3DO control pad.

Left-Shift Right-Shift

| SREATIVI

Button B

Button C

£ "
Button X Button P Button A
(Stop Button) (Play Button)

Figure 4-8: The 3DO control pad.

Generally, you can use the X button to stop a 3DO title and the P button to
pause or play it. The circular button pad on the left gives you directional
control of an object in a 3DO title while the A, B, and C buttons on the
right allows you to activate a certain feature in a 3DO fitle. The specific
function of each button varies from title to title. Read the documentation
that accompanies each title for more information.

3DO Blaster User's Guide

Using Your Keyboard

3DO Player allows you to substitute the 3DO control pad with your
keyboard. When you do that, all the functions performed by the 3DO
control pad can be performed by the keyboard. Hence, you can use your
keyboard to control or play 3DO titles. Before enabling the substitution,
you need to define or map the control pad buttons to keys on your
keyboard.

To map control pad buttons to keyboard keys:

1. Select the Keyboard Mapping command in the Emulation menu.

The Keyboard Emulation Configuration dialog box in Figure 4-9
appears.

Figure 4-9: The Keyboard Emulation Configuration dialog box.

2. Click on the text box of the button that you want to define.

3. Press the key that you want to remap the button fo.

The key’s name appears in the text box.

Since the function of each control pad button differs
among titles, you may wish to change the mapped keys
when you start each new title. Choose each key logically
bearing in mind its function in the title and the speed and
frequency that you need to press it.

4. Perform steps 2 and 3 again for each mapped key that you wish to
change.

5. When vou are done, choose OK.
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To enable keyboard control of your 3DO title:

1. Select the Keyboard Emulation command in the Emulation menu.

The function of each button on the control pad is now performed by the
keys you defined in the Keyboard Emulation Configuration dialog box.

To use your control pad again, select the Keyboard Emulation command
again.

Using Your Joystick

4-10

You can also use your joystick (if you have one connected to your
computer) to perform the functions of the control pad. Your joystick can
then take the place of the control pad in contrelling your 3DO title.

Before you use the joystick, you should calibrate it. When it is calibrated,
the joystick is more accurate in its movements on screen.

To calibrate your joystick:

1. Select the Joystick Calibration command in the Emulation menu.

The Conirol Panel joystick calibration utility appears. Follow the
instructions on screen to continue.

Once you have completed calibrating the joystick, enable joystick control
of your 3DO title.

To enable joystick control of your 3DO title:

1. Select the Joystick Emulation command in the Emulation menu.

When you emulate the 3DO control pad with a joystick, several of the
3DO control pad buttons are remapped to your keyboard. This is because
there are not enough buttons on your joystick. The buttons on your
joystick are remapped with the A, B, and C buttons of the control pad.
The Right-Shift, Left-Shift, Stop, and Play buttons on your control pad do
not have buttons on the joystick to map to. If these buttons are needed by
your 3DO title, 3DO Player remaps them to your keyboard. Hence,
whenever you activate joystick emulation of your control pad, keyboard
emulation is also activated.

3DO Blaster User’s Guide

Using Your Voice

You can use your voice to control 3DO titles and your 3DO Player. To do
so, you need to have VoiceAssist installed in your system (before you
install your 3DO Blaster software). With VoiceAssist, you can use your
voice to activate all commands in a 3DO title and your 3DO Player.
Several custom user files with all the commands in 3DO Player and the
bundled 3DO titles were copied into your VoiceAssist directory if you
chose to install them during the software installation of your 3DO Blaster.
You need to train the commands in these files in order to use them. But
first, you need to select and make your own personal copy of the custom
user files.

You must create your own personal copy of each title’s custom
file. This is done to retain the original custom file for future use.

To make your copy of the custom user files:
1. Start VoiceAssist.
2. Click the Menu button,
A drop-down menu appears.
3. Select the User command.
The User & Application Files dialog box appears.

4, Select the custom user file you want to use. If you are using
VoiceAssist to control a bundled title, select the user file for that
title. Otherwise, select the generic 3DO Player user file called
3DOPLAY.

Choose Copy.
6. Enter your desired name of your new user file.

Choose OK.

Your new file’s name appears in the list of user files.
8. Verify that your new user file is selected and choose Close.
A personal copy of the custom user file you want to use is now made. If
you want to use another custom user file, ensure you make a copy of that

file and use the copy.

You can now begin training the commands in your personal user file.
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To train commands:

Customizing 3DO Player

1. Start 3DO Player so that your user file can be enabled.

2. Click VoiceAssist’s Menu button. You can customize your 3DO Player by doing the following:

A drop-down menu appears.

3. Select the Training command. & szt eaDO Blayer Wandoy

A training dialog box showing all the commands in your user file Change Screen Modes

appears. Change Color Key

) Change Overlay Display Mode
If you selected a bundled title’s custom file, you can see

commands specific to that title below the commands for
the 3DO Player. If you selected the generic 3DOPLAY
user file, commands to control the control pad are listed
below the commands for the 3DO Player. You can train
these control pad commands to control your specific title
by speaking the title’s commands for the respective control
pad buttons that activate them.

000D

Adjust Volume

Resizing the 3DO Player Window

Like other Windows applications, you can resize the 3DO Player window
to suit your viewing preference.

. : ! To resize the window:
4. Choose All to train all the commands or Single to train only the

commands you want to use. 1. Click and drag any corner or side of the window to your desired

The Voice Training dialog box appears. .

- 2. Release the mouse button.
5. Select the number of trainings you want and choose OK.

6. Speak the command into your microphone. Your 3DO Player window changes to the new size. Notice that the player

When you are finished, begin training for the next command. screen also changes, altering the aspect ratio (ratio of width to height) of
3 e the image in it.
7. When you have finished training all commands, choose Save.

o

Y t the 3DO Pla ind t; foth licatio
The trainings for the commands in your user file are now saved. { N A e ol iy

windows even when another application is active. To do so, select
the Always on Top command in the View menu. With this feature
enabled, you can watch your 3DO titles’ images when you are
using another application.

You can begin using VoiceAssist to control your 3DO Player and title.
Refer to your VoiceAssist User’s Guide for more information on using
VoiceAssist.
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Changing Screen Modes
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When 3DO Player first starts, it is always a window. You can change the
3DO Player to full screen mode so that images from your 3DO title occupy
the entire screen.

To change the screen mode:
1. Select the Full Screen command in the View menu.
The image displayed enlarges to full screen and the menu and status bars

are disabled. When you are in full screen mode, the following hot keys
will be useful:

<Ctrl><R> Reset 3DO Player.
<Ctrl><A> Freeze image.

<Ctrl><Z> Unfreeze image.

<Alt><+> Increase volume.

<Alt><-> Decrease volume.
<Ctrl=<C> Change color key.
<Ctrl><O> Change overlay display mode.
<Ctrl><K> Enable keyboard emulation.
<Ctrl><E> Map keyboard.

<Ctrl><J> Enable joystick emulation.
<Ctrl><L> Calibrate joystick.

<Fl=> Enable online help.
<Alt><F4> Quit 3DO Player.

To revert to windowed mode again, click the left or primary button of your
mouse or press <Ctrl><F>.
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Changing Color Key

Images from your 3DO title are displayed through a specific VGA color.
This color is called the color key. Wherever this color appears on your
monitor screen, images from your 3DO title are displayed through it.
Hence, instead of seeing that color, you will see images from your 3DO
title.

The factory default color key is magenta. If your monitor screen has a
large amount of magenta visible resulting in 3DO images appearing
outside of the player screen, you need to change the color key to a VGA
color that doesn’t appear or is not anticipated to appear on your monitor
screen.

To change the color key:
1. Sclect the Color Key command in the Control menu.

The Color Key dialog box in Figure 4-10 appears. The currently
selected color key is the square with images showing through it.

Figure 4-10: The Color Key dialog box.

2. Select the color that is not visible on your menitor screen or one
that occurs the least.

3. Choose OK.
Images from your 3DO title now appear only in the player screen. If 3DO

images still appear sporadically on your monitor screen, select another
color key for your 3DO Player.
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Changing Overlay Display Mode

4-16

Your 3DO Blaster's graphics engine uses a technique called interlacing to
display the images from your 3DO title. Interlacing displays images by
dividing your screen into alternating odd and even horizontal lines. The
way these lines are used to display the images depends on the overlay
display mode being used. The four modes available are: Computer Mode
Field 1, Computer Mode Field 2, Anti-flicker TV Mode, and Anti-tearing
TV Mode. Their usage of the odd and even lines are as follows:

U Computer Mode Field 1 uses only the odd lines to display images.

U Computer Mode Field 2 uses only the even lines to display images.

O Anti-flicker TV Mode uses both odd and even lines to display
images. The odd and even lines are used alternately to display an
image.

O Anti-tearing TV Mode uses both odd and even lines to display
images. All the odd lines are used first to display the images, then
the even lines.

By using different modes, you can change the look of the images from
your 3DO title.

To change the overlay display mode of your 3DO Blaster:

1. Select the Video Overlay command in the Controls menu.

The Video Overlay dialog box in Figure 4-11 appears.

Made Field 1:

Eew
i f

! Computer Mode Field 2

O Anti-flicker TV HMode

) Anti-tearing T¥ Mode

E
i

Figure 4-11: The Video Overlay dialog box.

The default mode is Computer Mode Field 1 which uses
only the odd lines.
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2. Select an overlay display mode using the following instructions:

O If you want to use either the odd or the even lines to display
your 3DO title’s images, select Computer Mode Field 1 or
Computer Mode Field 2 respectively. If the overlay display is
in Computer Mode Field 1 and your 3DO title’s images appear
clear and sharp, we recommend that you do not change to
another mode.

Most 3DO titles use Computer Mode Field 1 to display
images (only the odd lines are used). This results in
sharp images when you select that mode. Some titles
use Computer Mode Field 2 to display images. For
these titles, Computer Mode Field 2 gives a sharper
look while Computer Mode Field | gives a softer look.
The effect each mode gives depends on which mode
your title’s developer uses. Most developers use
Computer Mode Field 1.

O If you want to use both odd and even lines to display your 3DO
title’s images, select either Anti-flicker or Anti-tearing TV
Mode. Images displayed in Anti-flicker TV Mode do not
flicker. But fast-moving images exhibit the “tearing effect”
(edges of fast-moving images secem to “tear” away from other
images). Fast-moving images displayed in Anti-tearing TV
Mode do not have the “tearing effect”. But some images
flicker when viewed closely in that mode. If your title does not
have fast-moving images, select Anti-flicker TV Mode. If it
has fast-moving images, select Anti-tearing TV Mode.

3. Choose OK once you have selected your overlay display mode.
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Adijusting Volume
You can adjust the volume of the 3DO Player.

To adjust volume:

1. Select the Volume command in the Control menu.

The Volume control in Figure 4-12 appears.

i

e I

Figure 4-12: The Volume control.

2. Move the slider thumb upwards to increase the volume or
downwards to decrease the volume of your 3DO Player.

3. Choose OK.

You can also click the Increase Volume or Decrease Volume buttons in
the tool bar to adjust the volume of your 3DO Player.
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Saving a Title

Certain 3DO titles offer a save feature that enables you to store a title in
your 3DO Blaster memory (in the 32 KB of battery-backed SRAM).

When this save feature is used, you can quit the title and start it again later
at the point where you saved it. For example, if you are at level 4 in a
game title, vou can save the title at this point and quit the title. When you
start that title again, you can continue playing it from level 4, the point
where you saved it. Consult your respective 3DO title’s documentation on
how to save and start the title. Different 3DO titles have different
characteristics of saving and starting.

As you save more titles into the SRAM on your 3DO Blaster, you need to
be aware of the amount of free memeory left in the on-board SRAM. You
can refer to the capacity indicator at the top of the Storage Manager screen
to see the percentage of free and occupied memory.

To view the Storage Manager screen:

1. Remove any CDs from your Creative CD-ROM drive’s disc tray
and close the tray.

2. Wait a few seconds for the 3DO Blaster introduction screen shown
in Figure 4-13 to appear.

Figure 4-13: The 3DO Blaster introduction screen.

3. Press button X on your control pad or the X button equivalent on
your keyboard.

The Storage Manager screen appears.

If the capacity at the top of the screen shows a small amount of free
memory or no free memory (all 32 KB of SRAM is occupied). you need to
delete one or more saved titles in order to vacate SRAM space to store
new titles.
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To delete a saved title:

1. From the displayed list of saved titles, select the one that you want
to delete and press button A on your control pad.

A prompt to confirm the deletion appears.

2. Press button A to confirm.

The selected title is now deleted from the list. The amount of memory
space occupied by each saved title depends on how much information
needs to be saved by that title. See the Storage Manager’s title list to see
the amount of space occupied by each title.

When you have finished viewing the Storage Manager screen, press button
X to exit. Load the title that you want to play into your Creative
CD-ROM drive.

Quitting 3DO Player
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To quit 3DO Player:

1. Select the Exit command in the File menu.
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Changing 3DO Blaster Hardware
Setting

This chapter shows you how to change the configuration of the jumpers on
your 3DO Blaster. It provides you with instructions on how to remove
and place the plastic jumper blocks that help define jumper configurations.

The appendix is sectioned into the following:
O Changing Jumper Configuration
0O Changing Base I/O Address Jumper

Do not change the default base I/O address of your 3DO Blaster
unless absolutely necessary, such as in the case when there is a
hardware conflict with another peripheral device. If you do change
it, remember to run the 3DO Configuration utility to update the
statements in your AUTOEXEC.BAT and CONFIG.SYS files.

Changing Jumper Configuration

Each jumper on your 3DO Blaster can be configured to different settings
by changing the locations of the jumper blocks on it. Before changing the
configuration of a jumper, you should identify the current and the
proposed new seftings. You can then proceed to change the location of
the jumper blocks.

To change the location of jumper blocks:

1. Touch your system’s metal casing to discharge any static electricity
from your body.

(o]

Switch off your computer and all other peripheral devices.

Remove the system’s cover and your 3DO Blaster from the system.

o

Using Figure 5-3, identify the pair(s) of jumpers to place block(s)
on for your desired base 1/0 address setting.

Changing 3DO Blaster Hardware Setting 5-1



5. Remove the jumper block(s) from the pair(s) of pins that do not
need the block(s) as shown in Figure 5-1.

Figure 5-1: Removing jumper block.

5. Place the jumper block(s) as shown in Figure 5-2.

Figure 5-2: Inserting a jumper block.

6. Install your 3DO Blaster in your computer.
Refer to Chapter 2 for installation instructions.

7. Switch your computer on.
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Changing Base 1/0 Address Jumper

The factory default base I/O address is 260H. This is represented on your
3DO Blaster by a unique configuration of jumper blocks on jumper JPS5.
By rearranging the jumper blocks on JP5, you can obtain other base I/0
addresses for your 3DO Blaster. Other base I/O addresses available are
270H, 280H, and 290H. Their corresponding locations of jumper blocks
and the factory default’s are shown in Figure 5-3.

=5 When you select a base 1/0 address, ensure that no other peripheral
device is using that address. Otherwise, a hardware conflict will
occur between your 3DO Blaster and that device.

q

Figure 5-3: The configuration of jumper JPS5 for available base 1/0 addresses.

JP5

ER G

260H 270H 280H 290H

If a hardware conflict occurs again, select another base 1/0 address for
your 3DO Blaster.

If your audio card has a CD-ROM interface installed and your
audio card’s base I/O address is set at 260H or 280H, please
observe the following:

O If your audio card’s base 1/0 address is set at 260H, do not
set your 3DO Blaster’s base I/0 address to 260H or 270H.

O If your audio card’s base 1/0 address is set at 280H, do not
set your 3DO Blaster’s base I/O address to 280H or 290H.
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Using 3DO Video Overlay Setup

The software in your package includes the 3DO Video Overlay Setup
utility. If your 3DO title’s images do not appear when you run your 3DO
Player or if the images are misaligned with the player screen, use 3DO
Video Overlay Setup to adjust the video overlay settings of your 3DO
Blaster so that it can synchronize with your VGA card.

To start 3DO Video Overlay Setup:

1. In the 3DO Blaster program group, double-click the 3DO Video
Overlay Setup icon.

The 3DO Blaster Video Overlay Setup dialog box in Figure A-1
appears.

3DO0 Video Overlay Set

H high. ¥ low
- {H low. ¥ high
 {Both high

Figure A-1: The 3DO Blaster Video QOverlay Setup dialog box.
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Load your CD-ROM drive with a 3DO compatible CD. Wait a few
seconds for the drive to read the data in the CD. 3DO images should
appear in the 3DO Blaster Video Overlay Setup dialog box.

If no images appear, click on each option in the VGA Sync Setting list box
until you see an image. Each option represents a synchronization setting
of which one will correspond to your VGA card. If your display is in
Hi-Color mode, the Dual Edge check box will be usable. Enable it to see
if the images have a better appearance. The 64K Mode check box is also
enabled by default if your display is in Hi-Color mode. If you want (o use
32K Hi-Color mode, disable this check box.

Once images appear, you need to fine-tune their alignment with your VGA
card. The misalignment is caused by the video and VGA clocks when they
are not synchronized. Use the controls in the Fine Tuning Settings group
box to synchronize the clocks.

To align displayed images with your VGA card:

1. Use the slide bar as follows:

@ Click the Horz Start radio button to enable horizontal
alignment of the displayed image. Move the slider thumb to
the left to shift the image to the right or move it to the right to
shift the image to the left.

O Click the Vert Start radio button to enable vertical alignment
of the image. Move the slider thumb to the left to shift the
image downward or move it to the right to shift the image
upward.

psfin,

Adjust the slider thumb so that it is positioned at the center
of the display area.

2. If a thin vertical line appears on the left or right side of the
displayed image, use the DAC Skew adjustment to get rid of the
line. Click the appropriate DAC Skew radio button to change the
digital-to-analog converter’s skew factor (the DAC numbers
correspond to skew factors).

3. If the displayed image on screen is wavering, use the VGA Skew
Factor adjustment to select a stabilized image. Click the
appropriate VGA Skew Factor radio button to change the VGA
clock timing.

Once you are satisfied with the alignment of the displayed image, choose
OK to quit 3DO Video Overlay Setup. Your adjustments will be evident
when you next start 3DO Player.
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Troubleshooting Guide

This appendix provides you with causes and solutions for some common
problems you might face. You can also double-click the 3DO PLAYER
README icon in the 3DO Blaster group for more troubleshooting
information.

Problem Error in opening MCI Driver or 3DO Player.

Causes 3DOBLST environment string was not set up properly.

1.
2. The applications were not set up properly.
3. 3DO Blaster was not installed correctly.

Solutions 1. Check that the AUTOEXEC.BAT file contains a
statement similar to:
SET 3DOBLST=C:\3DO A:260
Make sure that the path of your 3DO Blaster software
is specified correctly if it is not C:\3DO. Also, ensure
that the parameter settings reflect those of your 3DO
Blaster. If any of the entries are missing, you need to
run the 3DO Blaster Configuration utility(double-click
that icon in the 3DO Blaster group).

2. Run SETUP.EXE again (see Chapter 3).

Refer to Chapter 2 to install 3DO Blaster again.

Problem No video image.

Causes 1. VGA Feature Connector cable or VGA Loopback cable
is not connected to the video card.

Software was not set up properly.

bl

CD-ROM drive not functioning properly.

Solutions 1. Refer Chapter 2 for the correct connections.
2. Refer to Chapter 3 to reinstall the software.

Ensure that your CD-ROM drive’s ID is set to 0. If
problem persists, refer to your CD-ROM drive’s
manual for more troubleshooting tips.
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Problem
Cause

Solution

Problem

Cause

Solution

Problem

Cause

Solution

Problem

Cause

Solution

Displayed image has magenta or black border.
Image is not aligned with the VGA monitor.

Run the Video Overlay Setup utility in Appendix A.

Flickering of VGA screen.

1. Some connections are not secure.

2. Screen resolution is not supported.

3. Video overlay is in the wrong mode.

1. Ensure that the VGA Feature Connector and VGA
Loopback cables are secure.

2. Ensure that the maximum resolution of your VGA

color mode is set to 800 x 600. (For best perfomance,

we recommend using 640 x 480 resolution.)

3. Run 3DO Blaster Video Overlay Setup to adjust the
display before running 3DO Player.

Flickering of displayed image.

1. Some connections are not secure.

2, CD-ROM drive may not be functioning.

1. Ensure that the VGA Feature Connector and VGA
Loopback cables are secure.

2. Ensure that your CD-ROM drive or CD are in good
condition, e.g. no scratches on CD surface.

SBCD gives an error message during bootup even though
jumper JP5 and the base 1/0 address entries of your 3DO
Blaster in the AUTOEXEC.BAT and CONFIG.SYS files
are set correctly.

LPT2 of your system’s I/O card is activated.

Reconfigure LPT2 to another parallel port (refer to your
1/0 card’s manual) or select another base I/O address for
your Creative CD-ROM drive (refer to Chapter 5 and
Chapter 3).
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Technical Support

We are committed to giving you the best product as well as the best
technical support. When you contact us, please have the following
information ready:

U Hardware configuration information such as the base 1/0 address
used.

O Error message on the screen and how it came about.

U Information on the adapter card that conflicts with your card.
This section shows where you can contact us:

U Inside U.S.A., Canada and South America
O Inside Europe

O Inside Asia

0O Through Compuserve

Inside U.S.A., Canada and South America
CREATIVE LABS, INC. Technical Support

1523 Cimarron Plaza
Stillwater, OK 74075

US.A.
Tel : (405) 742 6622
Fax : (405)742 6633

BBS : (405) 742 6660
Operating Hours (U.S.A. Central Time)

Mon-Sun : 8:00 am-12:00 am (16 hours)
Public Holidays : Closed
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Inside Europe
CREATIVE LABS (IRELAND) LTD. Technical Support

Blanchardstown Industrial Park

Blanchardstown

Dublin 15

Ireland

Ireland Tel : (353) 1-820-7555
Fax : (353) 1-820-5052

France Tel ¢ (33)1.39.20.04.21

UK Tel ©(44) 734-344744
BBS : (44) 743-360287

Germany Tel @ (49)2131-102838

BBS : (49)2131-919820

Note: Inside Europe, please direct all faxes to Ireland.

Inside Asia
CREATIVE TECHNOLOGY LTD. Technical Support

Blk 75, #01-04

Ayer Rajah Crescent

Singapore 0513

Tel @ (65)773 4048

Fax @ (65)773 0353

BBS : (65) 7762423

Operating Hours (Singapore Time)

Mon-Fri 1 9:00 am-6:00 pm
Sat : 9:00 am-1:00 pm
Sun & Public Holidays : Closed
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Through Compuserve

To serve you better, we have created a Creative Labs Forum on
Compuserve. Through this forum:

0 You will have direct access to our company representatives who
will be there to answer your questions.

O You will be part of an interactive community of Creative’s product
users. Here you can share experiences and ideas and also seek
solutions to problems.

0O We will also keep you up-to-date on the latest product
information, software updates, and fixes to common problems.

O We will also welcome your recommendations and suggestions for
new products and for improving our producs in future releases.

If you are already a member of Compuserve

To access the forum: type Go Blaster at the Compuserve prompt.

If you are not a member of Compuserve (valid only in US.A.)

We have arranged for you to receive a free introductory Compuserve
membership which includes:

O one free month of Compuserve’s Basic Services,

0 a US$15 introductory usage credit to explore the Creative Forum
and Compuserve’s other Extended Services,

O a private User ID Number and Password, and

O a complimentary copy of CompuServe Magazine, Compuserve’s
monthly computing publication.

To receive this special offer:

O Call 1-800-524-3388 and
Ask for Representative #228.
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3DO Blaster General Specifications

This Appendix contains specifications of your 3DO Blaster.

Display Specifications
O 32-bit RISC CPU
O 64 million pixels/second animation
O 1 MB VRAM handling up to 16 million colors

Video Overlay Specifications

O 512K 16-bit video overlay supporting 800 x 600 resolution and
64K colors

Audio Specifications
O 16-bit digital signal processor for CD quality sound

Memory Specifications
U 2 MB main RAM
0 1 MBROM
O 32 KB SRAM with battery backup

1/0 Addressing

0 Jumper selectable base 1/O addressing at 260H, 270H, 280H, and
290H
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Connectors

External
O Two DB-15 connectors for VGA IN/OUT
O One DB-9 connector for 3DO control pad

Internal

a

O0O0OoO

VESA compliant VGA Feature connector
CD-ROM bus connector

CD-Audio connector to CR-563 CD-ROM drive
CD-Audio connector to Sound Blaster

FMYV daughterboard connector
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Cables
CD Audio 1-3
VGA Feature Connector  1-2
VGA Loopback 1-1
Calibrating joystick 4-10
CD3DOBLT.SYS
explained 3-7
Colorkey 4-15
Compuserve C-3
CONFIG.SYS file
modifications to  3-6
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VGA card 2-10
VGA feature connectors  2-10
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Connector
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E
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Full screen display  4-14

H
Hardware Conflict 2-2, 5-3
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Installing

Video Blaster RT300 2-2

J
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VGA input  2-10
VGA output  2-10

IPs 1-7, 5-3

Jumpers  1-3
base I/O address 1-6
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L
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M
MCI Driver B-1

P
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R
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S
Saving a playing title  4-17
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SETUP.EXE

explained 3-4

running  3-1
Software installation path  3-3
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Storage Manager 4-17
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Uninstalling software  3-7

Y
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Card, connecting to  2-10
Input jack 2-10
Monitor, connecting to 2-12
Output jack 2-10
VGA color and resolution  B-2
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changing A-2
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